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= Bai 1: Tdng quan
= Bai 2: Hé diéu hanh Windows
= Bai 3: Mang may tinh
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g Noéi dung chinh =

Mot s6 rng dung c6 san trong Windows
M6t sb ng dung quan ly, thao tac trén tap tin
U'ng dung doc van ban Acrobat Reader

B6 wng dung van phong Microsoft Office

a &> L bh =

Mét s6 ing dung trén Internet
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N (, - -

g 0i dung chinh :gii

1. M6t s6 rng dung co6 san trong Windows
ng dung tinh toan: Calculator
U’ng dung soan thdo van ban: Notepad

Ung dung dé hoa: Paint

YV V VY VY

Ung dung xem phim: Windows Media Player

Mét sé chuong trinh (g dung 5
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% Calculator R ——

==
—

= ng dung thuc hién cac phép tinh sb hoc.
= Start > All Programs > Accessories > Calculator
= May tinh chuan

 Mac dinh hoac chon View > Standard

Hé théng nut
phuc vu tinh toan

don gian

Mét sé chuong trinh (g dung 6
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% Calculator R ——

==
—

= May tinh khoa hoc

 Chon View > Scientific

Hé théng nut
chon lwa hé co s6

4 )

E Calculator

Hé th(“)ng Edit Yew Help
nut | 0|
==
phUC vu 1OHex ®Dec O0ct COBin ! (*)Degees () Radians () Grads
tinh toan O
, e [ ] Hyp Backszpace CE | | C

phirctap | \--mmmmmmmommmoooo oo 5
1
: F-E [ 1 M i Fi a 9 4 bod | | And
1 1
1
i dons || Esp || i | [ MR [E[ 4[| 5 [ B || < || or ||
1 1
1 1
! 3 %7y long MS [ 1] 1 2 3 - Lsh || Mot
1 1
1 1
H 3 coz || %73 nl M+ | 1] 0O + . + = Int
1 1
1 1
H Drat tan || «"2 || 1/ T E C I E F
i
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-

% Notepad L ——

= ng dung soan thdo van ban don gian.

= Start > All Programs > Accessories > Notepad

B

Motepad overview ~

£ Untitled - Notepad
'HE'E@T?&%&'WEM'Haﬂ

Motepad 15 a basic text editor that you can use to create simple documents,
The most common use for Wotepad is to wiew or edit fext (.txtg files,

but many users find notepad a simple tool for creating web pages.

Because Wotepad supports only very basic formatting,

wou cannot accidentally save special formatting in documents

that need to remain pure text.

This is especially useful when creating HTML documents

for a web page hecause special characters

or other formatting may not appear in your published web page
Or may even Cause errors.

¥ou can save your nWotepad files as Unicode,
ANSI, UTF-8, or hig-endian unicode.

These formats provide you greater flexibility when
Thanh working with documents that use different character sets.
cudn
ngang

Mot sé chuong trinh tng dung 8
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= 'ng dung d6 hoa don gian.

= Start > All Programs > Accessories > Paint

:-".-': THCS - Paint

Tin tiac co oo

Thanh
cubn
—_—
lllllllllllllli
T e e
For Help, click Help Topics on the Help Menu. 456,145 203x51

Mét sé chuong trinh (g dung 9
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g Windows Media Player L —

= ng dung xem phim anh

= Start > All Programs > Windows Media Player

G Windows Media Player =13

File View Play Tools Help

or i

:::Jser Thanh
B diéu khién

Olor ol & @I

Mot sé chuong trinh tng dung 10
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% Néi dung chinh —f

2. Mét s6 irng dung quan ly, thao tac trén tap tin
> ng dung quan ly tap tin Total Commander
> ng dung nén tap tin WinZip

Mét sé chuong trinh (g dung 11
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Total Commander P —

d -

= 'ng dung quan ly tap tin gibng Windows Explorer
= Start > All Programs > Total Commander > Total
Commander
= M6t sO chirc ndng co ban
 Tao thw muc: F7
Tao tap tin: Shift + F4

Xem ndi dung tap tin van ban (.txt): F3

Sao chép tap tin/thw muc: F5

Di chuyén tap tin/thw muc: F6
« Xoba tap tin/thw muc: F8

Mét sé chuong trinh (g dung 12
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we 0tal Commander

= Total Commander 7.01 - University of Amsterdam ._ E”Zl
Files Mark Commands Met Show Configuration  Start 1 Help
2B EE R % e A FE MRS D
Lnone_] 5.763.136 k of 8.377.864 k free \ [none_] 5.763.136 k of 8,377.864 k free \
Rl -\ W INDOWSL- = S
Ext |Size Date At THame Ext |Size Date Altr
<DIR> 10/03/2008 15:59--- e -] <DIR> 10/02/2008 23:35%--- |~
[_I[addins] <DIR> 10/03/2008 04:20--
[ [AppPatch] <DIR> 10/03/2008 04:22----
[ [Config] <DIR> 10/03/2008 04:20---
[T [Connection Wizard] <DIR> 1070372008 04:20----
[J[Cursors] <DIR> 10/02/2008 21:27--- —
[J[Debug] <DIR> 10/03/2008 04:22----
[&][Downloaded Program Files] <DIR>  10/02/2008 21:29--s
[ [Driver Cache] <DIR> 10/03/2008 04:20---
[T [ehome] <DIR> 10/03/2008 04:21----
[T [Fonts] <DIR>  10/02/2008 23:1 87~
[_J[Help] <DIR> 10/02/2008 21:28---
[[ime] <DIR> 10/02/2008 21:31----
[T [inf] <DIR> 1070252008 23:24--h-
[T [Installer] <DIR> 1040372008 15:33-hs
[Tljaval <DIR> 10/03/2008 04:20---
[J[Media] <DIR> 10/03/2008 04:21----
[ [msagent] <DIR> 10/03/2008 04:21----
[ [msapps] <DIR> 10/03/2008 04:20---
[ [mui] <DIR> 10/03/2008 04:21----
(=51 [Dffline Web Pages] <DIR> 10/02/2008 21:2%---
[T [pchealth] <DIR> 10/02/2008 23:16---
[J[PeerNet] <DIR> 10/03/2008 04:21----
[J[Prefetch] <DIR> 10/03/2008 15:48--- -
Dk /0kinD /0 files 0k /76151 kin 0 / 82 files, 0 / 38 dir[s)
cAWINDDWS> v
F3 View F4 Edit F5 Copy F& Move F7 HewFolder F3 Delete Alt+F4 Exit

Mot sé chuong trinh tng dung
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d

WinZip

=4

= (Png dung nén va giai nén tap tin/thw muc
= Start > All Programs > WinZip > WinZip 11.0

Menu
he
thong

==

&) WinZip Pro

File Actions Miew Jobhs Options Help 1
-~ b , . = . - A - -
B2 O A D e Q@
(i : |f__= i’ = -:_. % HE
Qpen Favorites add Exkract Encrypt gy Checkout ‘Wizard Wigw Skyle
Mame Type Modified Size | Ratio Packed = Path
Choose "Mew" to create or "Open” to open an archive 6 O

Mét sé chuong trinh (g dung
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"

= Local Disk (C:)

File Edit  Wiew Favorites  Tools

Help

K_) Back \j L} p Search [L_r Folders -

Address (<ee CY

1. Chudt phai
vao tap tin/thw
muc can nén

roide

File and Folder Tasks #

®j Rename this Folder
[ Move this folder
Copy this Foldsr
&8 Fublish this Foldsk

—~
ll:J Dacuments and Settings

—

=
'l:J WINDOWS

ll':.j Prograrn Files

ll'—'j Irnages

Open
Explore
Search...

Sharing and Security. .
& Snaglt

3 Add to Zip file. ..

the web

Send To

I'-'i Add to Software, zip
30 Add to recently used Zip file  »

Cuk
Copy

&3 Zip and E-Mail Software.zip
3 Zip and E-Mail Plus. ..

Create Shorbouk
Delete

Other Places

i My Computer =
LE:j My Documents
() Shared Documents

& 1y Metwork Places 7|

Renarne

&3 Configure

Properties

Mét sé chuong trinh (g dung

Thuc hién nén trong Windows Exploref~——======
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& Thuc hién giai nén trong Windows Explorer———
—

= |Local Disk (C:)
File

Q= ©-

Edit Wiew Faworites  Tools  Help

L} p Search [L-» Folders v

Address Ge O

|

System Tasks Il:::’ Documents and Settings
A Hide the conkents of
l@ this drive p——
. uot pnal Il:.J WINDOWS
vao tap tin/thw

muc can giai

n

Iﬂ Rename this file
a Mavve this file
D Copy this file
&8 Publish this File to the

| N

Ir Software

Ei! Open with WinZip

Prink
Explore

Ii-:'_j Pragram Files
G Images

|

) o

|

Web
() E-mail this file
i3 Prink this file

Other Places

%!pen Witk >
v

/ Send To

2. Chon -

Copy

Create Shorkeut

3 Extract ta...
J Extract ta here
30 Extract to Folder C:\Software
3 E-Mail Software.zip

3 Encrypt:

3 Create Self-Extractor { Exe)
3 Configure

'i MMy Computer

[} My Documents
[y Shared Documents
& My Metwork Places

Delete
Rename

Properties

Mét sé chuong trinh (g dung
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% Néi dung chinh g—— an

M6t s6 rng dung c6 san trong Windows

Mét s6 (rng dung quan ly, thao tac trén tap tin
U'ng dung doc van ban Acrobat Reader

BO wwng dung van phong Microsoft Office

a & w b =

Mét s6 ng dung trén Internet

Mét sé chuong trinh (g dung 17
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% Gidi thiéu g —
—
= Adobe Reader 1a mét sdn phdm cua hang Adobe
System, cho phép xem cac tai lieéu PDF (Portable
Document Format).
 PDF Ia mét dinh dang tap tin van ban kha phd bién cla
hang Adobe Systems.

« Viéc hién thj van ban PDF khdng phu thudc vao moi
trdng lam viéc clia ngwdi st dung (cau hinh may,
phan mém va hé diéu hanh) nén thuan tién cho phat
hanh sach, bao hay cac tai lieu khac qua mang Internet.

= Phién ban m&i nhat 1a Adobe Reader 9.0.

Mot sé chuong trinh tng dung 18
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d caiast (13

-

= Kich hoat tap tin cai dat Adbe

Rdr90_en US.exe

j;%.s;;#.duh_e Reader 9 - Setup

Destination Folder

| ]

1 1

Install Adobe Reader 9 ko 1

V| trl’ \/ /EG Zi\Program FileshadobeiReader .00 i

méac dinh A\ U '
sé cai dat

Click Mext ko install ko this Folder, or click Change ko inskall to a different Folder,

WaRMING: This program is protected by copyright law and international treaties,

Mexk = ] [ Cancel

) Change Destination Faolder, .. ] « Back. y

cai dat

ké tiép

Sang bu’c’rcj

Huay bé
viéc cai dat

Mét sé chuong trinh (g dung
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g Cai dat (2/3) P —

4

i Adobe Reader 9 - Setup

A

Ready to Install the Program
lick Install to begin the installation.
If wou want ko review or change any of wour installation Folder, click Back, Click Cancel to exit
setup.,
Adobe
[ < Back ] Install ] [ Cancel

Bat dau
cai dat

Mot sé chuong trinh tng dung 20
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g Cai dit (3/3) P —

4

i Adobe Reader 9 - Setup

A

Setup Completed

Setup has successfully installed Adobe Reader 9. Click Finish to exit setup.

fdobe

< Back | ; Finish Zancel

Két thuc
cai dat

Mét sé chuong trinh (g dung 21
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TRUGNG BAI HOC KHOA HOC TLF MHIEN R
KHOA CGNG NGHE THDNG TIN

BO MON TIM HOC COF s Vu ng

—giJg—

trinh bay
DE CUONG MON HOC van ban

Tén mén hoc : TIN HOC CO SO (45 tiét Iy thuy&t — 30 tiét thure hénh)

Muc tiéu : Sinh vién ndm dwroc nhibng kién thire nén ting v& hé thdng may tinh, céng
nghé thdng tin, mang may tinh, cac ky nang soan thao van ban, x Iy bang tinh, tao bai
thuyet trinh bang may tinh.

Cadng cu:

¥ Microsoft Windows XP
# Microsoft Office 2003

HOI DUNG MON HOC:

PHAN 1 : TIN HOC COr BAN (9t) v

Mot sé chuong trinh tng dung 22
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% Néi dung chinh g—— an

M6t s6 rng dung c6 san trong Windows

Mét s6 (rng dung quan ly, thao tac trén tap tin
Ung dung doc van ban Acrobat Reader

BO wwng dung van phong Microsoft Office

a &> e bh =

Mét s6 ng dung trén Internet

Mét sé chuong trinh (g dung 23
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i6i thiéu

do P

= Microsoft Office Ia bé rng dung van phong cua
hang Microsotft.

= Cac phién ban:

Microsoft Office 3.0, 4.0, 4.3

Microsoft Office 95, 97

Microsoft Office 2000

Microsoft Office XP

Microsoft Office 2003 (dwoc day trong chwong trinh)
Microsoft Office 2007 (m&i nhat)

Mét sé chuong trinh (g dung 24
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d Gisi thisu |
—
= Phién ban Microsoft Office 2003 gom cac rng
dung:
* Microsoft Word: soan thao van ban.
 Microsoft Excel: théng ké, tinh toan, phan tich.
» Microsoft Outlook: quan ly thw dién tu.
« Microsoft Powerpoint: trinh chiéu.
* Microsoft Access: quan ly co so dir liéu.
« Microsoft Visio: vé& biéu do.
« Microsoft Frontpage: thiét ké trang web.

« Microsoft Project, OneNote, Publisher, InfoPath, ...

Mot sé chuong trinh tng dung 25
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g Gii thiéu L
—
* 3 wng dung trong bd Microsoft Office sé€ dwoc gioi
thiéu la:
* Microsoft Word
« Microsoft Excel
» Microsoft PowerPoint
= Sau khi cai dat, cac rng dung nay nam tai:
* Menu Start > All Programs > Microsoft Office

« Hodc trén man hinh nén

Ed Ed
Microsoft i Microso {3 { Microso i
OFfice word} OFfice Excel CifFfic
2003 2003 PowerPaink
............................. 5003

Mét sé chuong trinh (g dung 26
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N

g 0i dung chinh :gii

5. M6t s6 rng dung trén Internet
Ung dung duyét web Internet Explorer

Ung dung thw dién t& Yahoo! Mail

YV V V

U'ng dung tan gau Yahoo! Messenger

» Ung dung tim kiém thong tin Google Search

Mét sé chuong trinh (g dung 27
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% Internet Explorer

o
-

= ng dung c6 san trong Windows, cho phép truy
cap vao cac trang web trén mang Internet.

= Start > All Programs > Internet Explorer

\_Jj D @ ;j ijEarch NFavurltes e‘MEdla @ E;-Q

Adglress |@ hktp:f fvaans, hcmuns edu, wnf V| . Go Lirks '@ v

Thanh

(JONG PAI HOC KHOA HOC TU NHIEN

dia chi

1 chanh

8, 1018 (GMT+7) » TuvEn sinh Cao d8ng QuBc k& (ITEC)

zhao mirng cdac ban dén vdi website

Truong PH Khoa hoc Tu Nhién

= Gidi thiéu

= | Bugc thanh 13p theo quyét dinh 1236/G0ET coa bd
| 3003/1996 trén oo & bach ra b Truding £H Tang ha)

gia wao BH Qudc gia TPHCM, Trirdng higén cd & khoa:

Zdng nghe thdng kin, W&k Ly, Haa hoo, Sink hoc, Bia

« | Bign k- Yien théng wa 4 BG mdn kruc thudic; 7 phén

Y | nSng; 11 Phéng thi nghim vwa 15 trung t&m nghién o

] 5an xudk dich wu,...

- ki FiEF

| >

&Snaglt E |§"

»

<

W

| Vung
hién thi

——_trang web

@ Done

Mot sé chuong trinh tng dung

ﬂ Internet
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w Yahoo! Mail

= Dich vu Internet cho phép gti nhan thw dién tur.

= Dia chi: http://mail.yahoo.com

3 Yahoo! Mail: The best web-based email! - Microsoft Internet Explorer,

File Edit  ‘iew Favorites  Tools  Help

@Back < @ @ @ @ \J_h pSearch "-‘i\\?FaVnrites QMedia @ B:t%v "_\ﬁ P |_J ﬁ

Address @ https: flagin.yahoo, com/configflogin_wverify2?8, src=ym V‘ Go Links ™ & & snaglt @ ﬁl

YK_HQO!@ MAIL ‘Yahoo! - Help

A~

bang ky
@ % e Chat right from 5::;0'37535' mail moi

your Inbox! Signing up is easy. ,\

l ¥ C a 2 same time ) Sign up for Yah

Already have a Yahoo! ID?

Sigh in
Now you have a whole new way to connect
with friends in the New Yahoo! Mail. @ Are you protected?
Creste your sign-in seal.
(Wb 7
@ See which of your Mail contacts are online at a glance.
‘fahoo! ID:

Pang nhéap
vao mail
da co

@ Chat right now — no download or setup reguired. |
(2.q. free2rhyme @yahao.com)

Instantly go from email to chat and back again. Pascward:

[ Keep me signed in

for 2 weeks unless | sign out.
[Unizheck if on & shared computer]

» Find out how to chat with friends from your Inbox today. Info

Faorget your ID ar password? | Help

&) 2 & mternst

|

Mét sé chuong trinh (g dung 29
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g Pang ky dia chi mail méi (1/3) .

‘2 Yahoo! Registration - Microsoft Internet Explorer

File Edit \iew Favorites Tools  Help ﬂ.
. 1 _ o | oy 3
e Back - e - @ @ {h p Search ‘*?/\5* Favorites w Media @ B - :; E |_J ﬁ
Address ‘@ https: ffedit,vahoo, comjregistration?. intl=usgnew=18&, done=http %38, fmail wahe V| Go | Links @ M & Snaglt @ Sy
)
HOO' Tahoo! - Help —3
Y& A
v - Already have an D or Mail address?
Hi there!
(9
We'l get you et up on ¥ahoo! in three easy steps! Just
wt answer a few simple questions, select an ID and password, Forget your pazsword or Yahoo! ID?
) ! and you'll be all =et.
| prefer contert from | Yahoo! U5, in English v
1. Tell us about yourself...
~ N ity X S ———— T
- Ten va HO My Name |Tin Hoc Co So ||Eh:| hdan | H -
c s g ) 1
- Gidi tinh Genter | Male v !
1
- Ngay sinh Birthday | January v [1 1Is2 |1
1
. > o 5 !
_ NO’| o | live in |V|etnam V| : - -
----------------------------------------- Dia chi
2. Select an ID and password :
' email
Yahoo! |0 and Ermail bmthes2008@yahoo.com  Change
Nhap’,\mat Fassword |uuu P-aﬂlgm'_ﬁﬁﬂwlgth
kh | Capitalization matters. Usze G to 22
characters, no spaces, and don't use your
name orrahao! 1D, Nhap Ial mat
Re-type Password |------ | kh%u "
@ é ﬂ Internet

Mét sé chuong trinh (g dung
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% Dang ky dia chi mail méi (2/3) -

‘2 Yahoo! Registration - Microsoft Internet Explorer

File Edit \iew Favorites Tools  Help E"
[ _ll-ll_ . . ' Py :_‘\
e Back - e - @ @ {;j p Search ‘*?/\5* Favorites w Media @ E,:% T E |_J ﬁ
Address ‘@ https: ffedit,vahoo, comjregistration?. intl=usgnew=18&, done=http %38, fmail wahe V| Go | Links @ M & Snaglt @ Sy
3. In case you forget your ID or password... W’
Alternate Email | |
Security Cuestion |What is the narme of your favorite book? V|
Yoaur Answer |Harr3,r Fatter
Use 4 characters or mare — not case sensitive. Céu héi Vé Céu
""""""""""""""""""""""""""""""""""""""""""" > AL ’ n~n
Just a couple more details. tra IO’I bl mat
L] ~ - 2
Type the code shouugsse F8T pB2 | khl quen dla 9h|
hoac mat khau
A = "
hap ma B2
xac nhan
(5] yau agree? | hawe read and agree ta the ahoo! Terms of Service and Yahoo! Privacy Policy, and ta receive
important communications from Yahoa! electronically.
| have alzo read snd agree ta the hail Terms of Service.
Far your canvenience, theze dacuments will be emailed ta yaur % ahoa! Mail account.
Create My Account Cancel B
b
& TaO S @ mternet
N >
, tai khoan
Mot sé chwong trinh (ing dung - 7
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‘A Yahoo! Registration Confirmation - Microsoft Internet Explorer

File —Edit  ‘iew Favorites  Tools  Help -'.‘l

eBack = \_/] @ @ \_;j pSearch g‘\g’Favurites ﬁrﬂedia @ [‘::'{' 3; _J ﬂ

Address &) https:/fedi.vahoo.comjregistration;_ylt=AowHZASWRIDBEOVIDE4ishkyz2PAl v | [Ed G0 Liks ¥ & @snaar B

Eat
HOO' Tahoo! - Help —3
Théng bao
H H ' hY Pl
Congratulations, Tin Hoc Co So! thanh cong
A canfirmation message was sent to you via email.
Below are your account details = Print Sccount Details
Y ou will need this infarmation to sign in to Yahoo! and to reset Véo
your passward in case you forget it. Please print and keep this Ready to experience R
infarmation in a safe place for future reference. Yahoo! Mail? hOp thU’
v A Yahoo! I & Email bmthes2008@yahoo.com
address: . D
Continue
R ; Birthday January 1, 1952
Thong tln Security Cuestion Yhat is the name af your favarite
oY A book? Install the new Yahaoa!
tal khoan - Toolbar and make Yahool
My Answer Harry Patter Mail faster.
(please follow the next few steps
to get wour new toolbar
Marketing Preferences
four Marketing Preferences: Select and customize the categories of communications you receive about v
< | =
@ Done é ﬂ Internet

Mot sé chuong trinh tng dung 32
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d H

Tao
thw
moi

Hop
th,u’
dén

Hop
thw
guri

0

p thw dién tuw

‘2 Yahoo! Mail (bmthcs2008B) - Microsoft Internet Explorer

File Edit \iew Favorites Tools  Help

Tén

\Kdﬁress‘@ hktp: fus . ma2. mail, yahoo, comfdeflaunch > “ GD Links > | &

Ox- O WG P | thikhoan [ @ 8= 6 LK

&Snaglt @ E‘

'MA'L bmthcsZ 008 /
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